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Operating a computer

How do you start up a computer?
To start up a computer you need to:

• turn on the power to the computer and the monitor
• turn on the power to any peripheral devices connected to the computer
• log on to the computer
• log on to the network if the computer is connected to a network
• enter a username and password if the computer and/or network is password

protected.

What happens when you start up a computer?
When a computer is turned on it carries out some instructions that are
permanently stored in its ROM (read-only memory). The process of starting up a
computer is known as the ‘boot process’.

The boot process involves the following tasks:

• it detects the processor type, for example, Pentium M
• it detects all the available devices including disks, keyboard, mouse and

monitor
• it looks for an operating system located on the hard disk 
• if an operating system is located, the system starts up. 

If the required files are not located, an error message is displayed.

What is an operating system
A computer needs operating system software to work. 

The operating system consists of a large range of smaller programs, each of
which has a specific task to carry out.

These programs are generally supplied with the computer. 
Intel-based computers usually operate with Microsoft Windows. Apple

Macintosh computers have their own operating system based on Unix. The other
popular operating system is Linux, a free version of Unix.

The operating system is used to carry out most of the tasks involved in
managing a computer. The functions of the operating system also include:

• control of the user interface—the way in which the user interacts with the
computer. Microsoft Windows includes menus, toolbars, task bars and icons.
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• communications, including Internet access and networking
• font management and use
• controlling the display on the monitor including the resolution and size
• starting, restarting and shutting down the computer.

What happens when a computer crashes?
From time to time a computer may stop responding because errors occur. Typical
errors are:

• a system crash with an error message
• a frozen screen when nothing appears to happen
• no response from keyboard or mouse actions.

Such errors can occur if a file stored on the disk is damaged. Errors are also
caused by conflicts in software—that is, system files needed by one program
conflict with system files needed by another program.

How do you restart a computer?
Every computer will need to be restarted from time to time when errors occur. To
restart using a key combination, press the CTRL, ALT and DEL keys at the same time.

In Windows XP, pressing these keys brings up a dialogue box that gives the user
a range of options, including shutting down, logging off or bringing up the Task
Manager. The Task Manager gives the user the option of ending one of the
processes that is currently running.

Occasionally, the key combination fails to shut down the computer. As a last
resort, turn off the power and leave the computer turned off for at least 30
seconds. Then turn on the power to start again.

Figure 3.1
Windows
desktop
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How do you shut down a computer?
The Shut Down command on the Start button in Microsoft Windows XP gives a
range of options including Shut Down.

At the end of the process it usually shuts off the power as well as closing
Windows. This may vary for different hardware configurations.
This command can be used to restart the computer if problems occur.

Managing a computer
A number of tasks need to be carried out to ensure the effective operation of a
computer. These tasks include:
• formatting disks
• creating, naming and renaming files
• saving files
• copying files and disks
• deleting files
• creating directories or folders
• finding files on a network or disk, or in a directory or folder
• backing up files
• printing documents
• installing and removing software
• accessing a network
• customising the computer setup through control panels and settings.

Figure 3.2
Shut Down
dialogue box 
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How is data stored?
Data is stored on a disk. A personal computer usually has a hard disk drive and a
CD-ROM or DVD drive. If the computer is connected to a network, the data may
be stored on a disk on the network.

What is a hard disk?
A hard disk is made up of one or more rigid platters coated with material that
allows data to be magnetically recorded. The disks rotate at very high speeds—for
example, 3600 revolutions per second. The disk has read/write heads that move
across the disk surface.

Hard disks can store large amounts of data. Their size is measured in kilobytes
(KB), megabytes (MB) and gigabytes (GB).

• 1024 KB = 1 MB
• 1024 MB = 1 GB

Hard disks range in size from 10 GB to 100 GB and upward. Most personal
computers are now sold with at least 20 GB of disk storage. 

What is a CD-ROM?
A CD-ROM is an optical disc that uses laser storage technology and can store
about 780 MB of files.

Many networks and libraries include banks of CD-ROM drives that can be
accessed by a number of users.

Computers with CD-RW drives, can read and write CD-ROM disks.

What is a DVD ROM disk?
DVD stands for digital versatile disk. It looks like a CD but it has a much higher
storage capacity. A DVD can consist of a number layers and can be single or
double sided. The storage capacity of a single layer, single side disk is 4.7 GB. The
maximum capacity of a DVD is 17 GB.

A CD-RW/DVD combination drive enables read and write for CD and also
DVD.

DVDs are used for:

• applications requiring a large amount of storage such as enhanced multimedia
and games

• high quality music
• video.

What about other storage devices?
A popular storage device is a zip drive that can be
attached to personal computers or incorporated
into them. A zip drive can store more than 100
MB of data.

USB key storage devices connect to a USB port
on the computer and can be easily connected
and disconnected.
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Another portable storage device is the IBM Microdrive that can store more
than 1 G of data.

USB Memory Keys
A USB memory key is a storage device that can easily be plugged into a computer
and requires no battery or software when used with Windows XP or Macintosh
OSX. These keys have a storage capacity up to 512 MB and beyond. Another
storage device is the Apple iPod that is also used as an entertainment device.

Disk partitions
A hard disk can be partitioned as part of the setup of a computer. This process
splits the disk logically into two or more disks.

The purpose of doing this is to allow flexibility in managing data and
applications. For example, a disk can be set up so that it has two parts—one for
storing applications and the other for storing data. This makes it easy to backup
data files.

Computer files
A file is a collection of related data. Every time you create and save a document,
you create a file.

Each document created is stored electronically on a computer disk. The file
can be recognised by its name.

Each operating system has a convention for naming files. For many years, the
convention allowed up to eight characters for the file name, followed by a full
stop (period), and three characters that identified the file type. For example, a
letter might have been named ‘Letter.doc’. The file name is ‘Letter’ and the
extension is ‘.doc’, which identifies the file as being one created by Microsoft
Word.

Windows now allows long file names with an extension. However, the extension
is not always shown on the screen.
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Naming and saving files
Each application creates files. The Notepad application is a simple word-
processing application. Starting Notepad opens a window into which text may be
entered.

The name of a computer file is made up of three parts:

• a name
• a full stop (or period)
• a three-letter code to identify the file type.

Notepad creates files with a ‘.txt’ extension.

Saving for the first time
Choosing Save from the File menu prompts for a file name, a file extension and a
location in which to save the file.

Any word-processing application is able to open a text (.txt) document. Other
applications use different extensions including:

Application File extension

Microsoft Word .doc

Microsoft Excel .xls

Microsoft Powerpoint .ppt

Adobe Photoshop .psd

Filemaker Pro .fp5

To open a file, double clicking on the icon that represents that file will open it
and launch the application that is identified by the extension.

Double clicking on ‘First document.txt’ will open the document and launch
Notepad.

Double clicking on ‘First document.doc’ will open the document and launch
Microsoft Word.

Saving files
Every document that is to be used again must be saved, usually to a hard disk.

If an application is closed and a file is unsaved, a warning is given that the file
needs to be saved.

Figure 3.3
Notepad text 
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Save command
The Save command on the File menu of most applications is used to write over
already saved documents. If a file is opened and changed, using the Save
command replaces the file that was on the disk with the changed file. It uses the
same name and does not give any warning that it will replace the file.

Renaming a file
Most applications have the Save As… command on the File menu.

Using Save As… allows the document to be saved as a file with a name—for
example, with the name ‘First document’ with the correct extension added.

To rename a file:

• select the icon representing the file
• click on the name of the file
• enter the new name for the file—the whole name is selected and will be

replaced. 

Alternatively, right click on the file icon and select the Rename option.
A file opened by an application may be saved with a different name using the

Save As… command on the File menu.

Where is a file saved?
Microsoft Office applications allow the user to choose where documents will be
saved. When it is installed, Microsoft Office creates a folder called ‘My
Documents’. Usually, documents will be saved in this folder unless the user
changes the location.

To change where a document will be saved, do the following:

• choose Options… from the Tools menu
• select the File Locations tab
• select Documents under File Types and click the Modify… button
• select the new folder or file location and click OK and then OK again.

Documents will now be saved by default in the selected location.

Figure 3.4
A warning that a
file is unsaved
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Copying files and disks

Copying a file
To copy a file to another disk, select the file by clicking on its icon. While holding
down the mouse button, drag the file icon to the icon representing the disk on to
which the file is to be copied and then release the mouse button. A window
appears showing the file is being copied. If the file already exists, confirmation is
required to write over the original.

A useful alternative is to select the icon representing the file and then click the
right mouse button. This displays a pop-up menu including the option Send To.
Selecting this option allows you to copy the file to another disk.

Copying a disk
To copy a disk to another disk, select the disk to be copied by clicking on its icon.
Drag the icon to the icon representing the disk on to which it is to be copied and
release the button. A window appears showing the disk is being copied. A folder is
created using the name of the disk that is being copied.

Figure 3.6
Using the right
mouse button to
copy a file

Figure 3.5
Copying 
a file to a floppy 
disk
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Deleting files
Files can be deleted in a number of ways. When a file is deleted in Microsoft
Windows it is moved to the Recycle Bin.

To delete files, do one of the following:

• select a file and drag it to the Recycle Bin
• select a file, right click it and choose Delete.

Deleted files remain in the Recycle Bin until they are removed. 
To do this, double click the Recycle Bin icon and select one of 
the following from the File menu:

• Empty Recycle Bin to permanently delete the files
• Restore All to remove the files from the Recycle Bin.

Creating and using folders
Folders are used to help you organise and arrange files. This should make it
easier to keep track of files and be able to find them easily when needed.

All current files could be stored in a folder called ‘My
Documents’, which is created as part of the Microsoft Office
installation. Another folder could be used for backups.

Files are usually stored in folders. A folder can either be
stored on the desktop or within another folder. When first

starting Windows XP, the My Documents folder icon is displayed on the desktop.
When software is installed, folders are usually created as part of

the installation process. For example, the files for the Microsoft
Office programs are stored in a folder called Microsoft Office that is
often located in a folder called Program Files.

Folder names should be meaningful to make them easier to
identify. File and folder names can be up to 255 characters in length. However,
some older software packages may not recognise names of this length.

New folders
To create a new folder, move to the area in which the folder will be stored, choose
New from the File menu and then choose the Folder option. A new folder, called
‘New Folder’, is created and typing over the current name can immediately
change it to whatever you choose.

Figure 3.7
The Recycle Bin

Figure 3.8
Recycle Bin
containing files

Figure 3.9
The My Documents
icon

Figure 3.10
The Microsoft
Office folder icon
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Tips for organising files
It is useful to have standard ways of naming and storing files. The following tips
can help you organise your files effectively:

• store files in the My Documents folder of the hard disk
• create folders and sub-folders to store documents of related subject matter
• relate the file name to the contents of the document—for example

‘resume.doc’
• if the new file would have the name of a file that already exists, add details

such as the date, for example ‘06resume.doc’.

Creating a CD Data Disk
Most CD authoring programs include the ability to:

• Create data disks
• Add data to a disk that is already created
• Create a backup CD
• Copy a CD
• Create a music CD

The ability to create a data CD provides a secure method of backing up
important data.

One such program is IBM RecordNow! installed on IBM notebook computers
that have optical drives able to write CDs.

To create a data disk, do the following:

• start the RecordNow! program
• select data disk

Figure 3.11a
Creating a data CD

WORKSHEETWORKSHEET
88888
Handling files



Operating a computer 29

• insert a blank CD into the optical drive
• give the CD a name
• select the files to be written to the CD
• click on the Burn button.

A message appears indicating that the disk is being created. When complete, a
message shows that the disk was successfully recorded and the disk is ejected.

Exploring Windows
An object such as a disk or folder can be ‘explored’ by selecting the object, right

clicking on it and selecting Explore from
the pop-up menu.

This is a file cabinet view of the files
and folders on a disk.

It displays two windows—the left
window gives an outline of the folders in
the disk, the right window enables a
view of the contents of any selected
folder.

Figure 3.11b
The interface used
to create the CD

Figure 3.12
Selecting Explore
from the pop-up
menu
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Clicking on a folder in the left window displays all the files and folders it
contains in the right window, and the folder is shown as being open. Clicking it
again closes the folder. Clicking on the + sign next to the folder displays the
folders within that folder; clicking on the - sign next to the folder hides the files
in the folder.

Double clicking on a file in the right window opens that file and launches the
appropriate application.

Finding files in Windows
Choose Search on the Start menu and select For Files or Folders… to search for a
file. Enter the file name, or part thereof, and click the Search Now button.

The list of files that meet the search criteria is shown in the Search Results
window.

Figure 3.14
Choosing Search
on the Task menu
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Figure 3.13
Explorer window
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This produces a Search window in which the file name is entered together with
a location in which to search. A list of files and/or folders that meet the search
criteria is displayed. There is a range of more advanced search options.

Backing up files
A backup of a file is a copy of that file stored on another disk. A backup is needed
in case something goes wrong with the original disk on which a file is stored.

Backup disks need to be carefully labelled and dated and stored safely. At least
two copies of every important file should be kept.

You should back up early and back up often!
Get into the habit of saving work every ten minutes or so to ensure a minimum

of work is lost. Always save a file before printing it in case something goes wrong
in the printing process.

Using automatic save
The automatic save function that many applications now include is useful for
ensuring files are regularly saved. In Microsoft Word, selecting the Save tab from
the Options command on the Tools menu can activate this.

If the AutoRecover option is selected, any document that was open at the time
of a power failure will open in its own window when Word is next started and any
loss will be kept to a minimum.

Figure 3.15
Displaying the 
files found
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A tip
Keep backups separate from your computer—in another location or in a different
room in your home. Do not keep backups in the bag with a notebook computer.

Why are backups needed?
Backups are needed because any of the following may occur to corrupt or damage
a file:

• power failures can cause the computer to shut down suddenly
• a software error can cause the files to be damaged
• computer viruses can cause files to be damaged
• a fault in the hardware may require software to be reinstalled after a computer

is repaired
• damage to the hard disk can be caused by knocking or moving when in use.

If the disk has to be replaced or reformatted, backup files will be required and
accidental deletion of a file from a hard disk will also require a backup to
reinstate the file. The user can change a file and then decide to go back to the
original file by using the backup file. If a computer is lost or stolen, backup disks
can be used to re-create lost files on another computer.

Microsoft XP includes a backup utility that allows files to be backed up to the
selected media. The utility also includes the ability to restore files when needed.

Figure 3.16
Save options in
Microsoft Word
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What about printers?
Printers are used to print text and graphics that have been generated by a
computer. The type of printer to be used depends on the following:

• the quality of the printing needed
• the speed of printing needed
• whether or not colour is required
• noise requirements
• cost of the printer—to buy and to run
• the type and quality of graphics to be printed.

What is a printer driver?
Each printer that can be connected to a computer needs software to make it
work. This software is referred to as a printer driver. The printer driver enables
the computer to communicate with the printer.

Microsoft Windows includes a universal printer driver, but each 
printer-specific driver needs to be installed. An icon representing each printer
that has been installed is stored in the Printers folder. The Printers folder is
accessed from the Settings option on the Start menu.

Figure 3.17
Microsoft Backup
Utility
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Default printer
A printer can be set as the default printer by double clicking on its icon and then
choosing the Set As Default option on the Printer menu.

Your turn
1 How do you carry out the following tasks? Write down the steps needed to do the

following:
a create a directory or a folder
b copy a file from one disk to another disk
c delete a file from a disk
d copy the contents of one disk to another disk
e find the most recently created file
f print a document that is currently being viewed on the monitor
g print a document that is stored on the computer.

Figure 3.19
Default setting

Figure 3.18
Printer drivers in 
the Printers folder
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2 What type of printers are you able to use at school? 
3 What types of printers are attached to your network at school?
4 Many printers have different quality options—best, better and faster, for example. Print

out the same file using each of the different settings available on a printer. Check the
quality of the print and how long each file takes to print.

5 Investigate the cost of buying a colour ink jet printer for use at home. Find out the
following things:
• cost of the printer
• cost of replacement ink cartridges
• speed of the printer
• the number of copies that will be printed from each ink cartridge
• whether or not it can print in black and white only
• whether or not individual colour cartridges can be purchased.

What is a computer virus?
A virus is a program that attaches itself to other computer programs. Once it is
attached it causes damage to files. A virus is spread when a file containing a virus
is accessed. Viruses can be loaded from computer networks, particularly the
Internet. Many viruses are distributed by attaching themselves to addresses in
email accounts. Address books in Microsoft Outlook are often targeted by hackers
because of Outlook’s widespread use.

Some other kinds of viruses
Worms: A worm is a computer program that replicates itself across a computer
network. It usually performs actions that cause damage to the computer’s
operating system including shutting down the system or using the computer’s
resources.

Trojan horses: “A Trojan horse is a program that claims to rid your computer of
viruses but instead introduces viruses to your computer.” (Webopedia)

Spyware: Spyware is software that covertly obtains information about a computer
system using the Internet. This is done without the user’s permission or
knowledge. Spyware is often hidden in software that is downloaded from the
Internet. When it is installed it tracks the activity of the user and sends that
information to someone else. Spyware can be used to:

• collect email addresses
• monitor passwords
• find out credit card details
• use Internet bandwidth.
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Why worry about a virus?
A computer virus can damage files on a disk. It can be selective or it can affect
every file. A virus can cause random system crashes and work can be lost. In the
worst case, a computer can become completely inoperative.

What can be done to combat the spread of viruses?
Use virus protection software that can combat the spread of viruses. Computers
often include anti-virus software when they are purchased. This software works by:
• scanning a disk each time it is inserted to see if it has a known virus
• running a virus checking program
• checking existing files on start up
• running in the background and continually checking files.

Other precautions to avoid a virus include:
• not borrowing disks or files from other people—whenever you borrow a disk

you run the risk of infecting your computer
• being wary of public domain and shareware programs
• purchasing and using only commercial software
• taking care when downloading files from the World Wide Web and bulletin

boards. Some games can be a source of viruses.

Note that virus protection software needs to be updated regularly. As new
viruses are detected, the software is altered to check for these viruses. However,
virus protection software is always going to lag behind the creation of viruses.
Updates of virus protection software are available on the Internet and should be
checked every week.

Figure 3.20
A virus checker in
operation
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What is a computer network?
A computer network is a number of computers connected to each other. A
computer network allows users to:

• work on a file that is on another computer on the save network
• print a document on a printer connected to a network
• send a message to another user on the network.

A computer network can span the whole world or be confined to a single room.
A network is made up of:

• nodes
• connections or links between the nodes
• computer software to allow connections.

A node on a network is any device that is connected to the network. It can be a:

• computer
• printer
• hard disk
• one of many other devices.

The links between computers are made up of any combination of:

• cable, such as coaxial cable or telephone wiring
• satellite transmission
• radio waves, called wireless networking.

Why have networks?
A network allows users to share information. Networks allow resources to be
shared, such as:

• printers
• large storage devices, such as hard disks
• CD-ROMs and DVDs
• backup devices
• large files.

A network can be as simple as two computers connected to share files. When files
are shared, each computer devotes some time to managing those files. This may slow
down the performance of the computer.

Figure 3.21
A computer
network
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How can I access the Internet?
At work, in a library or at school, Internet access is usually provided through a
Local Area Network (LAN) to the Internet Service Provider (ISP). This is often a
dedicated line open 24 hours a day, seven days a week.

The hardware needed to access the Internet from home is:

• a computer
• a modem to connect the computer to a telephone line
• a telephone line.

The software needed includes:

• software that drives the modem and allows a connection to the Internet
• browser software such as Netscape Navigator or Microsoft Internet Explorer to

access the World Wide Web.

The ISP—Internet Service Provider
At home, access is made using an Internet Service Provider. The ISP is responsible
for providing access to consumers based upon payment of a monthly fee. The
payment models vary depending upon the types of access required, the amount of
access and the amount of data that is downloaded.

The ISP will have a bank of modems and a large number of telephone lines.
When you dial up from home a connection is made using one of the lines
through the modems at each end of the connection. Once the connection is
made and authenticated, access is provided. When access is no longer required,
the communication is ended. Figure 3.22 shows how an Internet connection is
made. Figure 3.23 shows the home page of an ISP.

WORKSHEETWORKSHEET
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Figure 3.22
Connecting to the
Internet
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Broadband connections
Broadband connections provide a much higher bandwidth than a telephone
connection. There are two types of broadband connections available in major
cities:

• cable
• ADSL.

Cable connection
A cable connection uses a coaxial cable. This cable can also be used to provide
other cable services into homes, for example, cable television. This requires a
cable connection into the house and a cable modem connected to the computer.

Cable provides a much higher connection speed than a dial-up modem. Cable
is not available to all homes in Australia.

Figure 3.23  
An Internet Service
Provider allows
access to the
Internet
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ADSL
ADSL stands for Asymmetric Digital Subscriber Line. ADSL provides data to the
user at a rate of 256 KB per second to 1.5 MB per sec and the user can transmit
data at up to 256 KB per second.

ADSL is transmitted into the home using the existing Telstra telephone
network. It allows dual usage of the telephone line for both phone calls and data
transmission.

ADSL is not available to all homes in Australia.

Other connection types
Other types of connection to the Internet are available. These include:

• satellite
• microwave.

Satellite connection requires a satellite dish. Data from the Internet is
downloaded from the Internet. This can be useful when taking a significant
amount of data to the computer but to upload data another connection is
required.

A microwave connection requires transmitters between the home or business
and the ISP. It requires line of site connection. These are often used between
different offices of the one business or between school campuses.

Internet Service Providers—the market place
There are many ISPs in Australia. The market is rapidly growing and changing.
The telecommunication companies and pay television operators are all involved
in the industry.

What is a firewall?
A firewall is a system that protects a computer from hackers – that is, it prevents
unauthorized access to a network or to a computer.

On a network, a firewall is made up of:

• hardware
• software.

Large companies such as Cisco and Nokia typically provide firewalls for
networks in organisations. Every message that enters or leaves a network must pass
through the firewall that blocks those that do not meet the security requirements.

Personal firewall
Windows XP includes a personal firewall that is set up to block requests to
connect to a computer. This firewall is an application that is accessed via the
Control Panel.

Figure 3.24a  
Windows Firewall
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Your turn
1 Using a newspaper or magazine, identify four different Internet Service Providers.
2 Find the charges for two different ISPs. Answer the following questions:

a What is the cost of subscribing to the service? Does the subscription provide a 
number of hours per month access?

b What are the hourly rates?
c Which provider would be the best for your use at home?
d Are there any limits on downloads or time?

3 A person operates a small investment business from home. She needs to:
a access the Internet
b send and receive emails
c conduct share transactions with her online broker
d make regular data downloads of up to 250 MB per month
e be provided with web hosting facilities by her ISP 
f keep within her budget of $75 per month.
Choose the best value ISP for her.

Figure 3.24b  
shows the typical
firewall
configuration in
Windows XP
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Who owns software?
Specialist programmers develop software and, just like a book or a film, it is
original work. Companies such as Microsoft, Corel, Adobe and Macromedia
produce commercial software. It is illegal for copies of software to be made
without authorisation. An authorised copy can be made if the software publisher
allows a backup of original disks.

Do you own software when you pay for it?
Buying software does not give you ownership of the code that makes up the
software. You purchase the right to use the software according to the conditions
on the contract. Software is usually provided in a sealed packet with the licence
printed on the outside. When you break the seal, you agree to the conditions of
the contract.

Copy protection of software
Publishers of software try to prevent unauthorised copying and use of their
programs. Unauthorised copying and use is called ‘software piracy’. There are
severe penalties under the copyright laws for the sale and use of ‘pirate’ software.

Figure 3.25
A web page
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Some companies have a policy of using copy protection, others use only the
law. Some software can limit the number of users of a particular application on a
network. Publishers prefer not to use copy protection but see no other way to
protect their interests.

Example of a software licence agreement
FlyOnTheWall™ (©2005) by FlyOntheWall Software Incorporated.

FlyOntheWall Software Incorporated grants a free 30 day license for use of this software
(FlyOntheWall), starting from the date of receipt, after which time said software must be registered
with FlyOntheWall Software Incorporated with appropriate compensation and registration forms.
Under no circumstances may the software be used beyond the free 30 day licensing period unless the
previously stated conditions have been satisfied. You must purchase a separate copy of the software
for each computer it is used on.

Unless explicitly stated in writing, FlyOntheWall Software Incorporated does not grant permission
to distribute the software for profit in any form, including but not limited to, electronic information
service distribution, bulletin board distribution, and magnetic or optical medium distribution. Non-
profit distribution of the software is acceptable without prior written notice, providing that the
software is not modified in any way, and the complete works of the software are included in the
distribution package.

FlyOntheWall Software Incorporated is not responsible for any damage to the purchaser's
computer system or data and in no event will FlyOntheWall Software Incorporated, its officers,
directors, employees or agents be responsible to the purchaser for any consequential, incidental, or
indirect damages (including damages for loss of business profits, business interruption, loss of
business information and the like) arising out of the use or inability to use the FlyOntheWall Software
Incorporated product, even if FlyOntheWall Software Incorporated has been advised of the possibility
of such damages.

If you have any questions concerning the above license or do not agree with these terms, please
do not use this software.

Subscription software
Some companies offer a subscription service for software. Under this model, the
user pays an annual fee for the use of software. 

Your turn
Answer the following questions after reading the example above.
1 How long can you use the software for before paying? Why do software publishers allow

you to use the software for a period of time?
2 Can the software be distributed by others? Under what conditions? Could you place a

copy on your web site so that others could download the software?
3 To save space on your web site what could you do if you wanted to tell others about the

software?
4 Find examples of other software licences. How do they differ from the one shown above?
5 Why has the World Wide Web become so significant as a software source?
6 Do you think copy protection is a good idea? Give reasons for your answer.
7 If you produced a piece of computer software, would you copy protect your work? Give

reasons for your answer.
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Downloading software from the Web
Many types of software can be downloaded from the Web. Many sites give access
to trial versions and software updates. In some cases, the entire software package
can be downloaded. In these cases, payment usually needs to be made by a credit
card and a serial number of the activation code is sent to the purchaser.

Table 3.1 Types of software and licence terms

Software type Licence

normal full price price payable across the counter or via the Internet

academic or student teacher or student price, reduced from full price

trial software operates as a full version but expires after a period of time or number of
separate uses e.g. 30 days or 30 uses

feature limited software has features of full version but disabled in some key respect, e.g. does not allow 
(full version) file to be saved, does not allow printing, allows printing but contains watermark

feature limited software is a 'cut down' version of the full version.This is a working version and provides 
(lite version) most basic operations.

shareware software distributed as a full version for use for a period of time, after which the software
must be paid for. Some software will display a notice showing it is an unregistered version.

shareware software price is paid to a central software registry and payment remitted to the 
(Kagi system) software publisher.

freeware software is made available to others for no payment. Software can be used and in some
cases distributed to others providing the software remains unaltered.

Review questions
1 What is a file?
2 List the objects that make up a computer network.
3 What is an operating system?
4 Compare two different types of user interface. Which do you prefer and why?
5 How do you print a list of files in a folder on the screen?
6 How do you create a new folder?
7 Why are backup files important?
8 Why is virus protection important?
9 What is a Trojan horse?

10 What is a firewall? What does a firewall do?
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Now try these
1 What operating systems are used on the computers at your school?
2 Use a newspaper to find and compare the prices of different types of printers: an ink jet

printer and a laser printer.
3 Read the newspapers to find out the names of four computer viruses detected recently.

What effects did they have? How widespread were the viruses?
4 Find out which software at your school is copy protected. How is each piece of software

protected? Does it make it more difficult to use the software?
5 Obtain a copy of a software licence and read the small print.

a What does the licence allow you to do?
b Under what conditions can you copy the software?
c What are the obligations of the software company?

▲
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